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Created by Screen Printers for Screen Printers

Welcome to AccuRIP. Whether coming from another RIP or using a RIP for the first time, you will appreciate the ease of use and  
quality you get from AccuRIP.  We know you’re frustrated with other RIP solutions that require too much attention and fail to deliver 
the results in a timely manner.  Switch to AccuRIP today!

In a world of changing technology - let AccuRIP and Freehand Graphics be the stability you demand.

 

AccuRIP is simple to install and configure and even easier to use. 

For over 30 years Freehand Graphics has been screen-printing, color separating, developing software and educating screen-
printers. When our users asked us to put our experience into a screen-print specific RIP we took on the challenge and AccuRIP is 
the result. Built as a “core” system driver, once installed AccuRIP is a PRINTER choice listed in the Print Window of all of your  
applications. AccuRIP is not like other RIP programs. It was designed and programmed to handle one specific and important 
task and to do it extremely well.  Have a question or need some help - support is FREE!

AccuRIP Software: Operating Systems • Versions • Supported Devices • Software License

AccuRIP supports numerous Epson Inkjet printers for the hobbyist to the professional screen-printer.
For a current list of the various supported models (the list updates as drivers are added) please visit our website:  

www.softwareforscreenprinters.com/accurip

AccuRIP works with modern operating systems. For a current list visit our website:

www.softwareforscreenprinters.com/software

AccuRIP works in the background ready to deliver films made with your shop’s parameters. Just Hit PRINT and AccuRIP is called 
into action. It’s so easy - you just might forget about the technology behind your films!

AccuRIP is LICENSED for use to the original Licensee. AccuRIP can be transferred to another computer of the original Licensee 
by using the built in TRANSFER ACTIVATION feature located under the TRANSFER ACTIVATION MENU. AccuRIP can not be SOLD 
from the original Licensee to another user. Only Authorized Resellers of Freehand Graphics, Inc. and Freehand Graphics, Inc.  
are permitted to provide/manage AccuRIP Serial Number Licenses. For additional information, review the End-User License 
Agreement located online at: www.softwareforscreenprinters.com/accurip-link-3#

Serial Number Information can be found on page 21 of this User Guide.
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AccuRIP set-up is even easier with pop-up windows in the 
software.  An easy to understand explanation of a feature is 
at hand as you perform the set-up of AccuRIP.  Simply move 
your mouse over a selection.

Advisory Pop-Up Windows!

Droplet Weight Feature - up to 45 ink droplet options per resolution setting!

AccuRIP includes an expansive Droplet Weight (ink density) control ability. Per resolution there are 15 droplet weight set-
tings. You have the ability to dial in on the precise setting to achieve the needed density while gaining even greater control 
over the consumption of your ink. Users of AccuRIP’s All Black Ink System further expand the control under the “Ink  
Coverage” option which provides “Less, Standard and More “droplet weight settings (providing a total of 45 options).  
Greater control through easy clicks of the mouse makes this feature an extremely valuable one for our global user base. 
Enjoy!  For instructions see page 8.

FREE Support Options   •  24/7 Answer Center, Video Café and Live Agent Support

Reach a technician by submitting a support request online. It’s very fast and FREE. M-F 8:00 am - 6:00 pm EST.
www.softwareforscreenprinters.com - select the “GET HELP” icon.
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FREE Trial Information

NO WATERMARK on your films!  Go to press while you test AccuRIP!

Freehand Graphics wants you to be as confident with your purchase of AccuRIP as you have been with all other 
Freehand Graphics software. That’s why AccuRIP has a 14-day, fully-functional trial. Begin making money with 
AccuRIP from day one of your trial!

STEP 1
Download the AccuRIP Trial available at www.softwareforscreenprinters.com/downloads

STEP 2
Run the installer for AccuRIP.  This User Guide explains the simple set-up process (see page 5).

IMPORTANT Note: After trial registration you will see on-screen a $0 shopping cart receipt - close the window  
and the AccuRIP Setup Wizard will begin.

PURCHASE OPTIONS because we know you’ll love it... 

There are several easy options for purchasing AccuRIP Software at any time during your trial period or after the 
trial has expired.

Option 1 (Valued Resellers):
We encourage you to contact the Valued Reseller that introduced you to AccuRIP.  Your Reseller will be happy to 
handle your purchase for you and get you working with the full program as quickly as the same day.

Option 2 (Freehand Graphics):
•  Purchase online http://www.softwareforscreenprinters.com/store (during business hours)
• From within the AccuRIP Software go to the “Purchase Menu” for a secure purchase through the 
 E-Sellerate online option (24/7)
•  Contact Freehand Graphics at 631-744-4330 / 9:30 am to 5:30 pm EST / Mon - Fri / USA and a sales 
 professional will handle your order (during business hours).

 www.softwareforscreenprinters.com -and- www.accurip.net
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Step 1: Installation with Set-Up Wizard

ALERT - Never use Epson CD - ALWAYS Download Driver from www.epson.com
The Epson Drivers provided on the Epson CD are NOT the proper drivers for postscript needs. 
Download the Epson Driver at:
www.epson.com > Click USA > Select Get Drivers & Support > Printers & All-in-One Printers 
> Single Function Inkjet (locate your model).  

STEP 1:  Your Epson must be setup and operational (printing from the Epson Driver) prior to setting up AccuRIP. 

STEP 2:  Run the AccuRIP Installer. The AccuRIP Set-Up Wizard will appear (see picture below). 
First Time Users will enjoy AccuRIP’s Set-Up Wizard designed to make the already simple, one-time set-up process even easier 
and faster!   No Wizard? Launch the AccuRIP Software, go to: File Menu>Setup.

The Wizard will...
• walk you through the setup and connection of AccuRIP
• locate Locally connected as well as TCP (Ethernet printers)
• build drivers and print a test page
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Step 2: After the Wizard

1. The Set-Up Wizard completed the connection process and a TEST PAGE was made. 
2. Review your TEST PAGE (film output). 
3. Next Print the Droplet Weight Test Print (Chart) to FILM - select from 15 droplet weights per chosen resolution. You can 
select the droplet weight and resolution (fine tune the results) by choosing  “Set-Up” from within AccuRIP.  For example, you 
can adjust the ink droplet weight to lighten or darken your results or adjust the resolution for the best results. 

How to locate the AccuRIP Setup:  File Menu>Setup. 

AccuRIP offers a simple 3 tab set-up with just a few questions. The 3 Tabs are shown and described on the following pages. 
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Tab 1:  What printer do you have?

(a)  PRINTER
Locate then select your printer model from the convenient pop-down list of AccuRIP supported Epsons.

(b)  MEDIA 
Select Roll or Sheet Size and set the proper size. AccuRIP automatically sets the page size based on your document size in the 
application you are working in. Even though AccuRIP has this auto feature it is important to set the proper media size so you 
can take advantage of AccuRIP’s N-UP feature (ganging up/nesting). N-UP printing is discussed further in the Special Features 
section of this manual on Page 13 PLUS a PDF is available which can be located in your Applications/Program Files Folder/Main 
Application Folder in the AccuRIP folder. VIDEO: http://www.softwareforscreenprinterstech.com/video-cafe
Mac Hard Drive>Main Application Folder>AccuRIP>App Notes
Windows: C:/Program Files>Fawkes Engineering>AccuRIP

(c)  INK SET-UP 
Unchecked (by default) - AccuRIP will draw ink from the Photo Black Ink Cartridge.
Checked - is for users of the All Black Ink Cartridge-based bulk system (aka. All Black, Black Max). 

Hot Tips:
USB cables should be 6 feet long or 
shorter to avoid unnecessary data 
interruption/loss that could prevent files 
from printing completely or at all. Note: 
USB cable technology is not designed 
for long distance data transport of 
postscript data or of large files.

Your Epson printer MUST be 
connected directly to the host 
computer (where AccuRIP Software has 
been installed). Do not use HUBS. It can 
interrupt data flow causing fatal errors.

AccuRIP can easily be shared across 
your Local Area Network (LAN). A Serial 
Number can be used on one computer 
at a time. The User can transfer the  
Serial Number to a different computer if 
desired. See “Sharing” Videos online.

More details on all topics are in the web 
site Knowledgebase and Video Café.
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ALL BLACK INK Users:
AccuRIP reads the cartridge chips and instructs the inkjet to print (spray ink) from ALL of the ink cartridges which now have 
our formulated UV light blocking black dye. When using the All Black option make sure all cartridges are selected otherwise 
there will be an uneven draining of cartridges. Leaving cartridges unused (idle) may result in clogged inkjet heads and uneven 
draining - a main reason the All Black Ink system was developed in the first place!

Turning ON Multi-black displays all the ink cartridges in your printer and sets coverage to “Standard Ink”.  By default Ink  
Coverage is set to STANDARD. Droplet control allows you the ability to fine tune the amount of ink per droplet.

All Black Ink is an exclusive feature of AccuRIP Software and a high-production benefit designed to keep your device working 
as it was intended - with all cartridges in use regularly to keep the chances of a clogged nozzle to a minimum. For supported 
devices and info please visit http://www.softwareforscreenprinters.com/black-ink

Note: Wide Format Users must first install the Epson Starter Ink and verify the printer is in proper working order. Next, insert 
the All Black Ink Cartridges. Verify that all slots set and are read by the printer.  Perform a Power/Powerful Clean to clear the 
lines of color ink. This process takes approximately one hour. 

(d) PRINTER SETUP FEATURES to be addressed in AccuRIP Setup
- PRINT RESOLUTION
Choose Print Resolution from the pop-down menu. This feature controls the print resolution of your printer. Higher resolutions 
sometimes result in darker and more detailed prints but will result in slower printing times. Always try to get the best results 
you can using 720 x 720 or 1440 x 720 before raising the resolution.  For your purposes dye will perform better than pigment 
(UltraChrome K3).

- DROPLET WEIGHT
Next select droplet weight (ranges from 1 lightest to 15 darkest). The default is set to 6 which is a good starting point to 
determine what your needs are based on your brand of film. Droplet weight controls the flow of ink from the print head and 
has the greatest effect on a film’s density. Depending on your ink and film combination you may have to increase or decrease 
this setting. For very thick films that require a lot of ink you may need to use one of the heaviest settings. The proper weight for 
your film and ink is determined by printing the DROPLET WEIGHT TEST Print from the AccuRIP File Menu>Setup.

- BIDIRECTIONAL (High Speed Printing)
Bidirectional allows the inkjet head to spray ink in both directions (passes) and subsequently speeds file output. By default 
an inkjet printer only sprays ink when the head is moving right to left. As long as the film is not moving when the head is 
traveling left to right it is completely possible to spray ink accurately on the return pass. Single pass is more accurate but test 
Bidirectional to determine if the results are good for your purposes.

Bidirectional works best with new printers and the ability of an inkjet to manage bidirectional diminishes over time due to 
normal wear of the printer. If your printer starts to stage (move) film prematurely you may experience blurred printing. If this 
happens simply turn off the bidirectional feature and have your printer serviced. AccuRIP’s default setting is bidirectional OFF.
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- ADJUST PRINT LENGTH
This feature allows users of large format style printers (Epson 4000 and higher) to precisely control the length of prints over a 
long distance. The width of prints are unaffected. The registration from film to film is exact, but due to the stretching of media 
through the roller over a long length films can universally be short by 1/64th of an inch (0.0396875cm) or greater, which 
doesn’t matter to most screen printers because each film still registers. This has nothing to do with your RIP software - it has 
everything to do with the thickness of your film and your inkjet rollers. AccuRIP has addressed this need for precision industries 
(see below). 

So why has AccuRIP addressed this? 

Most screen printers don’t have the need for such exacting dimensions, but (for example) those that need to match films to 
“die cut” templates or have other specific dimension needs desire this control that AccuRIP can deliver.

How To...

1.  Located in the AccuRIP APP Notes folder>Film Feed Adjustment are pdf files named “Important Data Read First” and   
 “AccuRIP Print Length Accuracy Test.pdf”.
2.  “Drag and Drop” the TEST pdf file into the Queue Window of AccuRIP and it will print. The test print requires    
 17”(43.18cm) of PAPER (paper is the MASTER). Measure the result to be accurate.
3.  Load your FILM into the printer and repeat the TEST PRINT. Match the Film up to the Paper Master printout.
4. IF THEY ARE DIFFERENT LENGTHS... open the SETUP feature in AccuRIP and locate at the bottom of the first tab  
 (What printer do you have?) the “Adjust Print Length” feature.
5.  Positive numbers increase length while negative numbers decrease length.
6.  Starting with number 19 (+ or -) reprint the test to FILM until you have the desired result. Changes in increments of   
 10 make visual movements.
7. Print to FILM and match it to the Paper Master.

*It’s advised to check your settings each time you change film rolls or brands as variations during manufacturing may effect 
your printer’s film feeding rate. KEEP your PAPER MASTER in a safe location, and match the first print from your new roll for fast 
verification.
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Tab 2:  How is your printer connected?

Connection Type:
Select either Local or Network  (i.e.: Epson 1400, 1430, 1800 and 1900 select Local).

Local: locally connected printers such as USB, LPT1 or Firewire. 
Network: (TCP) (Ethernet) (WiFi) connected printers. Note: Firewire is only supported on Windows computers. 

Local connections: Windows computers will automatically pick up any printer connected via USB, LPT1 (Parallel) or Firewire.  
If you do not see a proper connection click “show all ports” (Windows only) and locate the proper printing port for your  
computer.

Network connections: (TCP/Ethernet/WiFi) a “dummy” address of 127.0.0.1 will appear in the address field. Do not attempt to 
connect using this false “dummy” address. New printers offer WiFi connections. Go online for WiFi connection info:
https://softwareforscreenprinters.zendesk.com/hc/en-us and in the SEARCH field type: WiFi and the ENTER/RETURN on the 
keyboard (several articles). 

Address: Enter a proper IP Address for your printer or network print server. If you don’t know what it is contact your network 
administrator for help, access the network setup from the front control panel of your Epson printer or use the “EpsonNet  
Config” software utility that can be downloaded from the Epson web site. Videos are also available in our Video Café.

Port: 9100 is the default port for inkjet printers*. 

Test: Click this button to test that you have a good (passed) connection to your printer.

Tab 2: Windows AccuRIP Setup (Local Connections) (left).  
Windows  AccuRIP Setup (Network Connections) (right).
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Tab 3:  How would you like this screened?

Screen: There are a few shapes to choose from when making a halftone screen. The default for AccuRIP is ROUND. There is also 
DIAMOND, LINE, and ELLIPSE. Choose the shape you desire. Round and Ellipse are the most commonly used shapes, but ALL 
will work well.

Lock Screens: This simple feature is your greatest asset. Not only does it prevent user error when printing films by universally 
overriding the setting in your various graphics applications to ensure proper film 
output, it also eliminates the need to address those settings in the graphics applications every time you need to print your file 
or separations – saving you a tremendous amount of effort and time.

When you select your angle in AccuRIP (i.e. 22.5 degrees) your halftones will all be printed at the same chosen angle - proven 
to be the cleanest printing method hands down (see next page for info on Flemenco Printing). Lock screens assures that  
AccuRIP controls the info provided to the printer and not your application(s). 

Want to use a Rosette? Simply TURN OFF Lock Screens and the control of angle and frequency is managed by the Design  
Application and NOT AccuRIP. Be sure to address it in the graphic program’s PRINT WINDOW.
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Angle: 
This sets the angle for the spot on your halftone screen. The default is 22.5 degrees and also known to be the best screen angle 
for screen making when exposed to mesh screen properly stretched at a 90 degree angle and looks best when viewed after 
printing. There are a few other angles that work well such as 61 degrees.

Frequency: 
Set your line screen value here. The default is 45 lpi which is a comfortable line screen for most textile screen printers. Set this 
number to your desired line screen. In order to choose a proper mesh count for a line screen multiply the lpi by 5 to establish 
the minimum mesh count to successfully capture this line screen. Choose the next HIGHER screen mesh and never lower. 
Example, 45 line screen times 5 equals 225. Therefore you should use a 230 mesh or higher to eliminate exposure moiré.

Dot Gain Control: 
Detailed instructions are available in our 24/7 Answer Center online: Article ACC-0203 and this EXPERT LEVEL advanced feature 
is to be used ONLY by those with a Transmission Densitometer that require exact control over dot size as it relates to dot gain. 
This is not a procedure that can be handled by eye. The most important factor is the use of good quality ink and film. With 
the use of better quality film brands dot gain is dramatically reduced or eliminated. Poor quality films dot gain the most. Give 
yourself the greatest chance for success. 

AccuRIP offers an Advanced Dot Gain control feature. Click the “Print Target” button. Be sure to print on the film you use to 
make screens. Using a DENSITOMTER read the film or a print of the test film and apply those numbers to the proper fields to 
adjust the RIP for the inkjet printer. You can also Save and Load the calibrations as needed. Additional info is online in our 24/7 
Answer Center online: https://softwareforscreenprinters.zendesk.com/hc/en-us   Search: Densitometer.

Understand that calibrations to film adjust the inkjet printer and not the printing press. For the most accurate calibrations it 
makes sense to calibrate the printing press so printing the Test Print on press and measuring that result tells you how much 
dot gain is created by the “printing press” allowing you to make the most accurate adjustments. Hard to do as there are chang-
ing variable on all presses. Most people just calibrate the inkjet printer and do their best on press to control inks and pressure.

Single Angle Printing (Flemenco Printing) is historically the best halftone printing method! 
Discovered in the late 1800s and patented by the Italian newspaper Flemenco, users moved away from single-angle print-
ing ONLY because of registration problems of the cmyk printing presses during that time period. Today the offset presses and 
screen print presses are far superior and have highly accurate registration processes. Screen-printers will find a remarkable im-
provement in their halftone printing by moving to single-angle printing (you’re welcome!)  Ask someone who is not convinced 
why single angle won’t work and they simply have no good answer other than someone they think was knowledgeable told 
them that once. Ask to see their prints and find out just how hard they had to work at them. The conversation always turns to 
the “secret angles” they have discovered and usually its that they simply line up the black and yellow screen which improves 
clarity and reduces dot gain. I always say “great idea” but why stop there? You have improved your print by only 50%. If you 
can line up two out of four colors and the world did not stop spinning then why can’t you line up all four? Usually followed by 
silence and a lot of brow ruffling. Now it sinks in and they smile.
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AccuRIP is a “Core Service” which means it is always on call, ready and waiting. Think of it as “sleeping until ready”.  Once you 
complete your set-up you do not need to open/launch AccuRIP to take advantage of its service whenever you wish to print. 

Simply choose the AccuRIP Driver that will be available in all Print Menus. Go ahead and print as usual.

AccuRIP On Call

Note: AccuRIP adds its driver to your list and does 
not remove or modify drivers as other RIP solutions 
can. It is friendly with your present setup.

N-Up Printing (Nesting or Ganging an Image) - This can be an Automatic Feature - LEARN HOW 

N-UP Printing (Auto Nesting) is a great automatic feature 
usually reserved for larger format inkjets, but AccuRIP 
brings this valuable ability to users of smaller format inkjet 
devices too. 

Simply stated, N-UP Printing dramatically reduces usage 
of consumables by automatically “ganging up/nesting” 
smaller images so they make the most of your film size. 
A small image will NOT sit alone in the center of your large, 
costly film. With N-UP Printing separation channels will 
share space on your film. This feature not only saves you in 
consumables but it saves output time.

PLUS: View our AccuRIP video...
www.softwareforscreenprinterstech.com/video-cafe

Original Art File

Film results with N-Up Printing



About Menu (Mac)
Mac users only can access the “About” feature (under the AccuRIP Menu and/or Title Bar) to view their AccuRIP Software  
version and build number. Handy for tech support and knowing when to update your software. Windows users can find the 
same information under the “Help” Menu.

Hide AccuRIP (Mac)
Hides the AccuRIP window.

Quit AccuRIP (Mac)
Quits AccuRIP the application only. AccuRIP is always available as a ready to select driver in all of your applications. Quitting 
AccuRIP does not affect your ability to use AccuRIP anytime. No need to launch the application AccuRIP to use AccuRIP.  The 
print services are always ready in your graphics program’s print window.  This is a great benefit of AccuRIP.
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N-Up Printing

HOW TO:
N-UP Printing is an “automatic” feature  activated when the page size (media size) of your graphic in any application is smaller 
than half the size of film selected in AccuRIP. To make the most of this feature simply make your page size (media size) just 
large enough to accommodate your image, registration marks and plate labeling. When AccuRIP sees that your page size 
meets the criteria it will automatically fit and organize as many images on a single film as possible.  AccuRIP applies division 
mathematics. For more information specific to your graphics program refer to the supplied PDF documents in the  
AccuRIP program folder. 

View our video...
http://www.softwareforscreenprinterstech.com/video-cafe  (Located in the AccuRIP section of the Video Café).

Read more at: https://softwareforscreenprinters.zendesk.com/hc/en-us   Search: N-Up or Nesting.

AccuRIP Menus Explained

The AccuRIP Menus are easy to navigate and for the most part the user will not need to use the features in the Menu.

Macintosh Menu Bar (shown in trial mode). Owners will have a
“Transfer” Menu instead so the license can be moved.

Windows Menu Bar (shown in purchased mode). 
Trial users would see “Purchase” rather than “Activation”.
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Under the File Menu you will find: 
Setup • Halftone Test Print • Droplet Weight (Density) Test Print • Quit (Quit is available here for the WIndows version only)

Setup:
Brings up the 3 Tab Setup Windows that we have discussed in length earlier in the manual. You can revisit the Setup any time 
you wish to change your AccuRIP settings such as when you switch to a different 
supported inkjet model or to change your shops desired lpi (line screen) (frequency).

Halftone Test Print:
As part of the AccuRIP setup we recommend you do a Test Print using our stock file to help you evaluate the structure and 
quality of the halftones you chose in the setup. Test Print will deliver a single piece of film with copy and graphics created 
specifically for your testing of AccuRIP. 

Droplet Weight (Density) Test Print **ADVANCED FEATURE**
This feature allows you to see the effects of the 15 droplet weight settings when printing films using your ink (dye/pigment) 
in your inkjet to your film brand.  Note: ink/film brands are important to your success and your ability to better control costs 
associated with ink usage. Waterproof brands are recommended.  

HOW TO USE THIS NEW FEATURE:
Go to the File Menu>Setup.  Step 1: choose a resolution. Step 2: turn off bi-directional. Step 3: Use the default Droplet Weight 
(in a Droplet Weight Test Print the chosen droplet weight in the Setup window will NOT have any effect on the test print). Step 
4: Only users of an “All Black Ink system” should have the multi-black feature checked on and ink coverage should be set to 
standard for the first test print. Raise or lower ink coverage depending on the results of the test. Your goal is to use the least 
amount of ink while still achieving the density you require to burn screens effectively. 

Quit AccuRIP (Windows):
Quits AccuRIP the application only. AccuRIP is always available as a ready to select driver in all of your applications. Quitting 
AccuRIP does not affect your ability to use AccuRIP anytime. Not needed to launch AccuRIP to use AccuRIP is a great benefit of 
the program.

Under the Jobs Menu you will find: 
Refresh Job List • Pause Job Processing • Resume Job Processing • Cancel Job • Delete Job • Cancel All Jobs

These are your controls for job queue or you can use the friendly icons in the Main AccuRIP Window! Roll your mouse over the 
icons for a pop up description.

Trash Can/Recycle Can: 
Deletes selected files from the Job Queue.
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Green Square: 
STOPS your job from printing.
The Jobs Menu also includes the option to Cancel All Jobs.

Double Green Bars: 
PAUSES the printing.

Green Arrow (triangle):
RESUMES printing. If the RIP is Paused you will see this displayed in the lower left corner of the AccuRIP window. It will say 
“RipCore Paused”. Click the “Resume” (Green Arrow) icon to turn printing back ON. The display should say “RipCore Ready”.

*AccuRIP can go into the “Paused” Mode any time a file is not fully printed. Causes can be from the printer not being turned on, 
a broken Network connection to the printer, even a bad file.

Under the View Menu you will find: 
Job History • Job Details • Tool Bar

Here is where you can control what Menus you see in the AccuRIP Window.  All Menus are “tear away” so you can configure 
your on screen appearance to suit your needs.  Job History and Details provides basic job information about the files sent and 
processed with AccuRIP.  Tool Bar can be viewed or hidden by checking or unchecking it under the View Menu. 

WINDOWS USERS:
Under the View Menu you will also find: 
Help • About

Help Menu (WINDOWS USERS ONLY): 
Windows uses will have access to a Help Menu.

About (WINDOWS USERS ONLY): 
In this location Windows users can access the “About” window and/or in the Title Bar to check their AccuRIP Software version 
and build number. Handy for tech support and knowing when to update your software to the latest build of their purchased 
version.
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Under the Purchase Menu you will find: 
Buy Online • Enter Serial Number 

This Menu is ONLY displayed in the trial versions. Once the software is purchased the Menu changes to ACTIVATION.

Purchase Menu: 
You can Purchase AccuRIP directly online. This provides for instant unlocking (just a few minutes). Your purchases are “secured” 
through E-Sellerate. 

Transfer Menu: 
Visible in versions that have had a serial number entered.

Transfer Activation: (requires Internet connection) If you need to “move” AccuRIP to another computer you must first 
“de-activate” the serial number before re-installing. It is advised to wait 20 minutes after de-activation before re-installing. 
This gives our security servers time to communicate and reopen access to your serial number.

Don’t “remove or delete” the software from the original computer AccuRIP was installed. Removing or deleting is not the same 
as de-activating. You MUST “de-activate” by doing a Transfer Activation before moving and re-installing AccuRIP. 

AccuRIP is a “single install” license that allows you to “share” the driver with your entire network not “install” and activate it on 
multiple computers. * Too many failed attempts at multiple installations will result in a security lock out and the need for you 
to contact tech support at: www.accurip.net and click the “Get Help” Menu.

AccuRIP can be TRANSFERRED from one computer of the Licensee to a different computer of the Licensee. AccuRIP can not be 
SOLD to another user/company. Review the End User License Agreement for additional information located at:
www.softwareforscreenprinters.com/accurip-link-3#
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The Job Queue, Job History and Job Details window are displayed together or may be torn apart to float on their own.

1. Job Control Tools: 
Located at the top of the Job Queue window (can be repositioned to the left side of the window by dragging and dropping). 
Use the Open file, Trash, Stop, Pause and Play icons to control jobs selected in the Job Queue.

2. Job Queue: 
Displays the present file printing and all the separations related to that file as well as all jobs waiting to be printed.

3. Job History: 
Click on any job previously printed to display Job Details. Mac and PC users can right click to reprocess jobs. Jobs with green 
check marks indicate  the job has fully processed - printed. Jobs with an “X” failed to process and may need investigation or 
possible reprinting from the application.

4. Job Details: 
Provides general information about the job (i.e. file name, Rip Time, etc.)

5. Status and Data Bar: 
Located at the bottom of the Job Queue window, it displays all critical data about AccuRIP and its network.

1

2
3

4

5
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Moving Windows:
The Job Queue, Job History and Job Details windows may be pulled apart (tear away / float). Click on the window name and 
drag, then release the mouse over the desktop. To resize the window, click and drag the lower right corner of the window.

To return the window to the Main Job Queue window click once on the Window Return icon 
located at the upper right corner of the window or click and drag the window name, releasing the mouse over the Job Queue 
window.

Close the window by clicking on the “X” located at the upper right corner of the window.

Open a closed window by going to the “View Menu” and selecting the window.

Have a PDF, PS or EPS file and don’t have an application for these files?
Simply drag and drop the file into the Job Queue.
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Printing with AccuRIP

With AccuRIP installed and your AccuRIP to Epson Driver for your specific model successfully built you are ready to output your 
graphics file/separations (solids, halftones, postscript data). The AccuRIP experience is much like working with a laser printer. 
AccuRIP is driver-based so there is no extra workflow or special requirements. In short - it is the easiest means to quality out-
put. AccuRIP is NOT a separation software or engine. It allows you to output separations to an Epson inkjet which is a  
non-Postscript device.

Know your Graphics Applications Print Window and Features:
AccuRIP allows you to print directly from your graphics application (i.e. Adobe Illustrator, InDesign, Photoshop, Corel DRAW, 
Photo Paint, Painter, Freehand, Flexi, Canvas and more). You will follow your usual file output procedures in these graphics 
programs and simply choose your AccuRIP to Epson driver as your printer.

If you are not familiar with how to navigate your graphics program PRINT Window and print features when outputting  
separations you should review your graphics program manual.  AccuRIP takes over the task of file output after you have made 
the proper selections in the Print Window of your design program (i.e. Illustrator, DRAW, Photoshop, etc.) To help the end-user 
we have posted documentation and have created videos that can be found online for the most common applications used by 
screen-printers such as Adobe Illustrator and Corel DRAW.   Visit www.softwareforscreenprinterstech.com (Video Café •  
Knowledgebase)

Which graphics applications can you print from?
You can print from any Postscript-based design program (there are many). The most commonly used programs in the screen-
print industry are Illustrator, Photoshop, DRAW, Photo Paint, Painter, Freehand, InDesign, QuarkXPress, Flexi, Canvas, etc. 

What are the typical selections in the Print Window that I will need to address?
To answer this question we have provided videos of Adobe Illustrator and Corel Draw in our Video Café located at  
www.softwareforscreenprinterstech.com/video-cafe  
Programs vary and versions within programs also vary so be sure to learn your Print Window well. But, anyone who has the 
task of printing files should already have the understanding of how to print “separations” as opposed to printing a color  
composite to an Epson using the standard Epson driver.

Note: 
Since AccuRIP Software is called into play after the Print Window selections are made, unexpected print results most often are 
related to file development or incorrect selections made in the Print Window. The hardware should also be on, in good working 
order, directly connected to the computer that hosts AccuRIP, have a proper length USB cable(6 feet or less) (no hub), and all 
ink cartridges inserted and with available ink. Printer errors or lights alerting you that your hardware has an issue need to be 
addressed before outputting your file as separations to film.
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AccuRIP Serial Numbers

Serial Numbers received at PURCHASE will unlock the trial for full use. Enter the Serial Number under the PURCHASE MENU of 
your AccuRIP Trial or in the Window provided during first-time installation. If you receive an error when entering the number, 
the most common reason is incorrectly keying in the information. Make sure that you COPY then PASTE the ENTIRE purchase 
code including the ACCU... into the Enter Serial Number field (see below).

If you type it in be sure that it is in ALL CAPS.  It must contain the dashes - and there are NO SPACES. 

When entering a Serial Number note that there are no letter O’s only number zeros in an AccuRIP Serial Number.

Unlock errors are: 
• user typing errors
• copy and paste errors (used just part of the serial number)
• users attempt to use a serial number that has already been activated on another computer.

The Error Message INVALID SERIAL NUMBER is a user input error and does not mean the Serial Number is not correct.

There are proper means to transferring your AccuRIP Serial Number off of one computer to be used on a different computer. 
This is handled by the user under the AccuRIP Software’s TRANSFER Menu. 
Information on Transferring a Serial Number is documented on page 17.
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THANK YOU for reading the AccuRIP User Guide! 

Contact Information

Freehand Graphics, Inc.
4250 Veterans Highway
Suite 3040
Holbrook, NY 11741
www.softwareforscreenprinters.com
631-744-4330 PH

24/7 access to valuable tech info and videos are online!

A valuable resource for AccuRIP software users as well as for general screen-printing information is located online in our 24/7 
Answer Center and Video Café.

www.softwareforscreenprinters.com (link to 24/7 Answer Center, Video Café and other valuable resources)
www.softwareforscreenprinterstech.com

FREE Tech Support: 
Submit a request for support online (Monday - Friday 8:00 am to 6:00 pm EST). We require each support question in writing. 
Use our convenient and fast online support ticket system:

 www.softwareforscreenprinters.com 

CLICK the “Get Help” Icon. Provide details so a technician can resolve your issue quickly.


